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Mac and Apple Terminology
Definitions of common terms, words, and technical jargon associated with

Apple and the Macintosh computer. To find a term quickly use ⌘ F

(Command Key %2B F) to open a search box and type in the term.

Keyboard Symbols:
⇧ shift key, ⌘ command key, ⌃ control key, ⌥ option key, ⇥ tab key, ⎋

escape key

Definitions

64-bit Architecture – 64-bit refers to the number of bits that make up

the structure of various parts of a processor’s architecture. These

structures usually include the data bus, address bus, and internal

registers.

.dmg file – A file containing a “virtual disk” that you can access by

double-clicking the file’s icon. Commonly used to bundle an

application’s install files into a single, easy-to-download package.

Activity Monitor – A Mac OS X utility (Applications > Utilities > Activity

Monitor) that lets you view the resources being used by your

computer.

Adware – Adware is a type of spyware that collects information about

your buying habits, as well as the web sites you visit. Adware uses the

information it collects to display advertising in your web browser or
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other applications that is keyed to your particular interests.

AirPort – Apple’s name for the common Wi-Fi protocols, 802.11b,

802.11g and 802.11n, used to network Macs (and/or PCs) together

wirelessly.

Alias – Aliases are small files that point to other files in the Macintosh

file system. Like shortcuts in Windows, aliases can dynamically track

the original file. An alias is a quick and easy way to access a file that

may be buried several folders deep.

Alt key (⌥ ) – Also called the Option key. Used in conjunction with

other keys for access to special functions. Found at the bottom of the

keyboard just to the left of the Command key.

Aperture – Apple’s professional photo management and retouching

app. Its main competitor is Adobe’s Photoshop Lightroom.

App – A common abbreviation for “application” – a software program.

AppleCare – Apple’s customer support and hardware servicing arm.

The standard AppleCare plan features 90 days of free phone support

and 12 months of warranty, but this can be upgraded by purchasing an

AppleCare Protection Plan.

AppleCare Protection Plan – An upgrade to the standard AppleCare

warranty and support service. The AppleCare Protection Plan (APP)

gives 3 years of warranty and technical support for products such as

Macs and iPods.

Apple Menu – The Apple menu provides access to items and services

that are always available, regardless of which application is currently

active. The Apple menu includes the Sleep, Restart, and Shut Down



commands and more.

Apple TV – A tiny device that plays content from iTunes, Netflix, Hulu

Plus, YouTube, and sports leagues on your widescreen TV. Plug in,

connect Apple TV to your TV using an HDMI cable, content streams

wirelessly to Apple TV using your Wi-Fi network.

Application – An application is a software program designed to

perform one or more computer functions.

AppleScript – An easy-to-learn scripting language that you can use to

automate tasks on your Mac. AppleScript programs can issue

commands to most Mac apps, making it easy to automate tasks such

as opening, editing and saving documents.

Archive and Install – A method of upgrading or re-installing the Mac

OS X operating system. The existing system files are moved to a

Previous System folder, and new system folders are created.

Automator – Like AppleScript, Automator lets you automate repetitive

tasks by issuing commands to applications running on your Mac. A set

of commands is known as a workflow. Automator is very easy to learn,

since it uses a graphical interface to construct workflows.

Backup – A backup is a copy of one or more of your computer data

files. You can back up your data manually, by copying files from your

hard drive to another hard drive or to removable media. You can also

use backup software to automate the process of backing up your files.

You can also backup your files to online sites using companies like

BackBlaze, CrashPlan, or Carbonite.

Backspace / Delete Key – Used to erase selected items or letters to



the left of the blinking cursor.

Bluetooth – A wireless technology designed for transmitting data over

short distances (between 1 and 100 are Bluetooth-enabled.

Boot Camp – A utililty that comes with Mac OS X, allowing you to

install Windows on your Mac in a separate hard disk partition. This

allows you to dual-boot – that is, choose to start either Mac OS X or

Windows when you start up your Mac.

Boot Disk – A boot disk is a digital data storage medium from which a

computer can load and run (boot) an operating system or utility

program. The internal drive in a Mac is the boot disk that is normally

used to start your computer. External disks containing a clone copy

can also be used to start your computer.

Bundle – A folder containing related resources that is presented as a

single “file” to the user. Applications and plugins are usually grouped

as bundles. Bundles are convenient to use – for example, to run an

application bundle, you just double-click the bundle’s icon.

Cache – A temporary storage area for frequently-accessed data. In mac

terms, the term Cache usually refers to the files stored in

~/Library/Caches.

Calendar – Apple’s calendar application that comes with Mac OS X.

iCal lets you create multiple calendars; view each calendar by day,

week or month; add events and appointments to calendars; sync your

calendars with other people; and create To Do items.

Click – One click of the mouse button. Used to select a document,

insert the cursor or activate a tool.



Click & Drag – to Click and hold down the mouse button while

dragging the mouse. Done to select objects, or to draw & also used to

drag a selected object to a new location, or to open a menu.

Clone – A copy of your entire hard drive that is contained on a

separate drive. Backup software such as Carbon Copy Cloner, or

SuperDuper! must be used to create a clone. Clones can be a vital part

of any backup plan since they can be used if your main hard drive fails.

Close – (⌘ W) Found under the File menu. Used to put away

documents or close folders. Use either the quick-key combination or

select the Close menu command. It will not cause a program to quit

(with the exception of Control Panel programs).

Command key – The key with the Apple and/or clover-leaf (⌘) symbol

(usually next to the space bar). Mainly used where you would use the

Control key on Windows.

Command-clicking – Refers to holding down the Command key and

clicking the left (or single) mouse button.

Console – A Mac OS X diagnostic tool (Applications > Utilities >

Console) that allows you to view various log files, such as the system

log and mail server log.

Contacts – Contacts allows you to create and maintain a centralized

repository of addresses and phone numbers  that other software

programs can access and use. It is one of the applications that Apple

bundles with Mac OS X.

Content Filter – A content filter allows you to control the web sites that

younger family members can visit. Content filters are a common



feature of web filtering software, which may also include time

management and other features. Mac OS X includes content filters, in

the form of managed user accounts.

Control-clicking – Refers to holding down the Control key and clicking

the left (or single) mouse button. Has the same effect as right-clicking

with a 2-button mouse.

Copy – Found under the Edit menu (⌘ C) – Used after selecting a

portion of text, sound, etc to be copied. Selection is most often

accomplished by click/dragging over the item.

Crash – When a program encounters an error in its operation, it may

freeze up and stop working. The program may even automatically quit.

When this happens, it is advisable to quit all other programs and

restart the computer, thus refreshing the operating system and

restarting the programs from scratch.

Cursor – The blinking line found at the active point of keyboard input.

It is repositioned by mouse clicking in a new position pointed to by the

Mouse Arrow.

Cut – Found under the Edit menu – (⌘ X) Used to erase a selected area

or object from a document. This action places the cut item in

temporary memory (clip board) that can be pasted into other areas

and/or documents.

Dashboard – Dashboard creates a special layer in the Mac OS X

operating system for running mini-applications called widgets.

Data – the digital information generated by the computer program

being operated. It is saved onto your personal data disk or your User



Partition.

Defrag – Fragmentation is caused by continually appending data to

existing files, especially with resource forks. With faster hard drives and

better caching many applications rewrite the entire file each time. Mac

OS X, unlike PCs, automatically defrags files and therefore does

require special software to do this job. SSD drives do not need to be

defragged.

Demo Software – A demo is a trial version of a software program that

you can use for a specified period of time before you decide whether

or not to buy it.

Desktop – The Desktop folder and the Mac desktop provide two

different views of the same information. The desktop is the first thing

you see after you log in to your Mac.

Dialog Box – a window that appears after selecting an action that

requires additional information or prompting from the operator. You

must answer the query found in the box before you may proceed to

the next step(s).

Disk image – A file containing a “virtual disk” that you can access by

double-clicking the file’s icon. Commonly used to bundle an

application’s install files into a single, easy-to-download package.

Disk Utility – A general-purpose Mac OS X utility (Applications >

Utilities > Disk Utility) for manipulating hard disks, CDs, DVDs, and disk

images. Features include verifying and repairing hard disks; creating

and burning disk images; formatting disks; and erasing disks.

Driver – A driver is a small software program designed to allow a piece



of hardware, such as a printer, to communicate with a computer and its

operating system. Drivers are operating system specific as well as

device specific.

Document – the data generated by operating a program.

Dock – The Dock is a ribbon of icons that serves several purposes. You

can launch an application from its icon in the Dock; check the Dock to

see which applications are currently active; and add icons to the Dock

for easy access to your favorite applications, folders, and files.

Double click – Two fast clicks of the Mouse Button. Used to open

documents and Launch applications. May also be used to select a

word in a text document instead of click/dragging over the word.

Drag – Used in conjunction with a click of the mouse. Moves the

selected item to a new location or moves the cursor across text or data

in a sound file.

Eject – Ejects the disk in the Disk Drive.

eSATA – eSATA: External SATA, a special cable and connector used

when SATA (Serial Advanced Technology Attachment) devices are

housed in external enclosures.

File Menu- Found at the top of the Macintosh screen, it is used to

open or close documents, as well as print, save & quit operations.

Finder – The app that lets you view and manipulate files and folders.

It’s the first app you see when you first log in to your Mac. You can

switch to the Finder by clicking the Finder icon on the left hand side of

the Dock.

Firewall – A firewall is a barrier that prevents unauthorized access to a



computer or network. A firewall may be hardware-based, software-

based, or a combination of hardware and software.

FireWire – FireWire is a high-speed serial interface used by computers,

camcorders, set-top boxes, and the professional audio and video

industry to interconnect equipment and computers.

Flash drive – Consists of a small data storage device with USB

connector which can be carried in a pocket or on a keychain. USB flash

drives are typically removable and rewritable. Drives of up to 256 GB

are available and storage capacities as large as 2 TB are planned. Also

known by other names, ie. thumb drive.

Flash storage – Essentially a really big USB memory stick instead of

using a standard Hard Drive which stores information on disks inside

the drive. Flash is very fast, reliable, durable and only takes minimal

space. Flash memory looks pretty much like RAM-sticks. (Also see

SSD.)

Folder – Similar to a file cabinet folder, it is used to contain related

documents.

Force Quit – Stop an application running immediately. Force quitting is

useful if an application has “hung” (become unresponsive and is

displaying the spinning beach ball of doom. To force quit an app,

switch to another app (such as the Finder) then choose Force Quit

from the Apple menu.

Fusion drive – The Apple developed technology combines a hard

drive with 128 GB of NAND flash storage (solid-state drive) and

presents it as a single logical volume with the space of both drives



combined. The operating system automatically manages the contents

of the drive so the most frequently accessed files, applications,

documents, photos and other data are stored on the faster flash

storage, while infrequently used items move to or stay on the hard

drive.

GarageBand – Apple’s music authoring software – part of the iLife

suite.

GB – Gigabyte – a unit of measurement of storage. A gigabyte is a

thousand million bytes (though it can sometimes be slightly higher

than this, depending on interpretation). One byte is enough to store a

single letter of the alphabet. Commonly used to refer to RAM and hard

disk size.

Get Info – (⌘ I) The Mac equivalent of Windows’ Properties dialogs.

With many items – such as files and folders in the Finder, or songs in

iTunes – you can right-click (or Control-click) the item and choose Get

Info to retrieve information on the object.

Grab – A Mac OS X utility (Applications > Utilities > Grab) for taking

screenshots on your Mac.

GUI (Graphic User Interface) – image of a file which Mac users can drag

and drop  into folders or trash.  First marketed by Apple on the Mac in

1984.  Now commonly used on most computer systems.

Hard Drive – A hard drive is a mechanical method of storing digital

information. There are two important things to be aware of when

you’re in the market for a hard drive: capacity and interface type.

Hardware – In terms of computers, hardware usually refers to external



components, such as printers or scanners, that you can see or touch.

Some internal computer components, such as the processor and

memory, are also called hardware.

HDMI (High Definition Media Interface) – a compact audio/video

interface for transferring uncompressed video data and

compressed/uncompressed digital audio from a HDMI-compliant

device.  HDMI ports are available on newer macs.

Home folder – The top-level folder for storing your documents and

other data. Each user on a Mac has their own Home folder, located

inside the /Users folder.

HTML – HTML is a markup language that specifies the formatting of

the content of web pages, including text, images, and links. HTML tells

a browser how to display a page.

Icon – A shape representing a document, program or disk. It may look

like a folder or a program graphic.

iLife – Apple’s suite of personal media apps. Contains iPhoto (for

photo cataloguing and basic editing), iMovie (for movie editing), iDVD

(for DVD authoring), and GarageBand (for music composition),

iMovie – Apple’s movie editing software – part of the iLife suite.

iMac – The original iMac was an egg-shaped, all-in-one desktop Mac

with a built-in color CRT display. The iMac has undergone many

changes during the years and is now available in both 21” and 27”

models.

iPad and iPad mini – Apple versions of a tablet display that offers

many of the same functions of a computer but is lightweight, easily



hand held, readily stored and operates on iOS. iPad currently is 9.5″ x

7.31″. The mini version is 7.8″ x 5.3″. Each is available in Wi-Fi and Wi-

Fi plus Cellular versions in a range of storage capacities.

iPhone – Apple’s smartphone that revolutionized mobile phone

communication. Using iOS the current version features retina display,

faster wireless performance, superb camera, in a very thin, lightweight

design.

iPhoto – Apple’s photo editing software – part of the iLife suite.

iPod touch – Retina display with similar to iPhone “smart” functions,

but without phone capability other than through Wi-Fi. Uses iOS.

Camera feature is inferior to iPhone.

iTunes – Apple’s free music management app, shipped with Mac OS X

and also available for Windows. iTunes is also used to sync various

Apple devices such as iPods and iPhones with Macs or PCs.

Inkjet Printer – An inkjet printer uses specially designed print heads

that can spray ink directly onto paper in specific patterns. Most inkjet

printers are four-color printers (cyan, magenta, yellow, black), although

six-color and eight-color printers are also available.

Incremental Backup – Most backup software performs two basic types

of backups, full and incremental. An incremental backup only copies

data that is new or has changed since the last time the same data set

was backed up.

iWork – Apple’s suite of Mac office apps. Features Pages (a word

processor), Numbers (a spreadsheet app) and Keynote (a presentation

app).



Java – a programming language and computing platform first

released by Sun Microsystems in 1995. There are lots of applications

and websites that will not work unless you have Java installed.

Reportedly java has caused some Macs to crash.

Keyboard – The typewriter-style keyboard used to enter text and

operate functions in programs. LaserWriter Printer – The machine that

prints your documents.

Keychain – Mac OS X’s central password storage system. Each user on

a Mac has a keychain, in which they can store login passwords,

encryption keys, and encryption certificates. This allows you to manage

all your passwords under a single login. You can view and edit your

passwords and other keychain items by running Applications > Utilities

> Keychain Access.

Keynote – Keynote is an easy-to-use presentation software application

that has cinema-quality presentation capabilities. Keynote is part of the

Apple iWork suite of office software.

Laser Printer – A laser printer is a printer that uses a light source

(usually a laser) to project onto a charged surface (usually a rotating

drum). Laser printers are available in color and monochrome versions,

in a wide variety of price ranges.

Launch – to start an application by double clicking on an application or

document.

LCD Display – A LCD (Liquid Crystal Display) is made from two or

more sheets of polarizing material, with a liquid crystal solution in

between them.



Lion: OS X 10.7 – Lion, more formally known as OS X 10.7, is the

seventh in the series of Unix-based operating systems from Apple.

Logging In – the procedure for gaining access to the computer or

server.

Log On – another term for Logging In.

Login Items – Applications, documents, or other things that you want

to open automatically whenever you log in. To set up a login item

choose Apple menu > System Preferences > Accounts > Login Items,

then click the %2B button.

Mac Mini – Fully functioning desktop computer in 1.5″ x 7.7″ square

enclosure. Offers fast desktop Mac performance at minimal cost.

Requires separate monitor, keyboard, etc. Also available in server

version.

MacBook Pro – The MacBook Pro is Apple’s professional line of laptop

Mac computers. First introduced in January of 2006, the MacBook Pro

was the second computer from Apple to make the transition from the

PowerPC processor to processors supplied by Intel.

Magic Mouse – Multi-touch area covers the top surface and the mouse

itself is the button. Scroll in any direction with one finger, swipe

through web pages and photos with two, and click and double-click

anywhere. Inside Magic Mouse is a chip that tells it exactly what you

want to do. Uses laser tracking that’s far superior to traditional optical

tracking.

Magic Trackpad- Multi-touch trackpad designed to work with Mac

desktop computers. Supports full set of gestures, giving you a whole



new way to control and interact with what’s on your screen. Inertial

scrolling makes moving up and down a document more natural than

ever. Connects to your Mac via Bluetooth. Use in place of  or in

conjunction with Magic Mouse on any Mac computer.

Malware – Malware, or malicious software, is any type of software that

is designed to cause damage, disrupt activities, provide unauthorized

access to a computer or network, or collect data about you without

your knowledge.

Menu Bar – The Mac OS X menu bar is a thin horizontal bar that spans

the top of the Mac desktop. The menu bar always contains the Apple

menu (identified by an Apple logo icon), as well as the basic File, Edit,

View, Windows, and Help menu items. The menu bar may also contain

items placed there by currently active applications. Unlike the Dock,

the menu bar cannot be moved to other locations.

Menu Select – Click and drag down to the desired menu item; release

the mouse to activate the command.

Messages – Apple’s instant messaging software, is included with Mac

OS X. Messages supports video, audio, and standard text-based

messaging.

MIDI (Musical Instrument Digital Interface) – a technical standard that

describes a protocol, digital interface and connectors; allows a wide

variety of electronic musical instruments, computers and other devices

to connect and communicate with one another. A single MIDI link can

carry up to sixteen channels of information, each of which can be

routed to a separate device. MIDI interfaces are particularly useful for



using Garageband.

Mountain Lion: OS X 10.8 – Mountain Lion, more formally known as

OS X 10.8, is the eighth in the series of Unix-based operating systems

from Apple.

Mouse Arrow – the active position of the mouse & is not active until

mouse is clicked. Open – Found under the File menu (⌘ O). Used to

open or launch files, documents & applications.

Multifunction Printer – A multifunction printer (MFP) combines

several different functions in a single printer, usually printing, scanning,

copying, and faxing.

Numbers – Apple’s spreadsheet application – part of the iWork suite.

NVRAM (Non Volatile Random Access Memory) – Your Mac stores

certain settings in a special memory area even if it is turned off.  On

Intel-based Macs, this is stored in memory known as NVRAM; on

PowerPC-based Macs, this is stored in memory known as PRAM. If you

experience issues related to these functions, you may need to reset the

NVRAM or PRAM. For example, if your Mac starts up from a startup

disk other than the one you’ve specified in Startup Disk preferences, or

if a “question mark” icon appears briefly when your Mac starts up,

resetting NVRAM / PRAM may help. Learn more here:

 http://support.apple.com/kb/ht1379

Optical Drive – In addition to a hard drive, most desktop and laptop

computers come with an optical drive, which is designed to read or

read and write optical media (CDs and DVDs).

Optical Media – Optical media is a generic term that refers to any type



of data storage media that uses light, usually in the form of a laser, to

read and/or write data.

Option key – A modifier key like Command or Control (usually sits

between the Command and Control keys on the keyboard). Often

used for secondary actions, or for entering accented characters. May

be labelled, Alt, Option, or ⌥.

Pages – Pages is a full-featured word processor included in Apple’s

iWork office suite. Pages comes with over 180 templates, and can

import and export documents in Microsoft Word format.

Partition or Partitions – Partitions are separate sections of a hard

drive. Partitioning is the process of physically creating separate

sections on a hard drive.

Parallels Desktop – A Mac application that lets you install Microsoft

Windows in a virtual machine (computer) on your Mac. You can then

run Windows apps and Mac apps at the same time.

Password – A special and unique word that is used to verify that the

individual is a registered & authorized user.

Paste – Found under the Edit menu (⌘ V) – Used to insert information

that was cut or copied from one location to another. Also used for

making multiple copies of a section or object.

Preferences file – A file that stores an application’s user preferences.

Most preferences files are stored in ~/Library/Preferences, and end

with a .plist extension. You can access system preferences from the

Apple menu and program preferences from the individual program’s

icon.



Preview – A Mac OS X utility for viewing images and PDF files. Preview

supports a large number of file formats, making it a useful general-

purpose image viewer.

Primary mouse button – The main button on the mouse, used for the

majority of actions. This is usually the left button (or the only button on

one-button mice) but this can be changed by choosing Apple menu >

System Preferences > Keyboard & Mouse > Mouse and clicking Right

for the Primary mouse button option.

Print – Found under the File menu (⌘ P) – Used to print the present

open document. Program – another name for a computer application.

Public folder – A folder in each Mac user’s Home folder that is

readable (but not writable) by all other users on the same Mac (or

another Mac on the same network). This allows you to share selected

files and folders with other people.

QuickTime – An Apple technology capable of handling audio, video,

images and other media in various formats. The QuickTime Player app

uses these technologies to allow media to be played back.

Quit – Found under the File menu (⌘ Q) when working in an

application. Used to stop all activity in that program and go back to the

desktop.

RAID (Redundant Array of Independent Devices) – OS X supports

several different techniques for storing data on multiple drives to

increase the performance and increase overall reliability.

RAM – RAM (Random Access Memory) is a computer’s main memory.

RAM temporarily stores parts of the operating system and any



applications you run, to allow faster access to data.

Restore – In terms of computers and backup software, a restore is the

process of recovering data from a backup, either manually or using

backup software.

Rich Text Format (RTF) – A RTF file can include information such as

text style, size, and color. RTF files can include images. The nice thing

about the RTF format is that it is a universal format, meaning it can be

read by nearly all word processors.

Safari – Apple’s Web browser that ships with Mac OS X and iPhone OS.

Also available on Windows.

SATA: High-Speed Hard Drive Interface – SATA (Serial Advanced

Technology Attachment) has been the hard drive interface method of

choice for Macintosh computers since the G5. SATA’s advantages over

other hard drive interface methods include faster transfer rates, thinner

and more flexible cabling, and easier plug-and-play connections.

Save – Found under the Edit menu (⌘ S) – This updates all data and

should be done every few minutes or so if you are working vigorously.

All changes made to a document after the last save will be lost if there

is a crash.

Scroll Bars – the gray shaded strips found at the right side and bottom

of all documents. They allow you to scroll across documents that are

bigger than your viewing area. The behavior of scroll bars can be

modified using System Preferences > Mouse, or Trackpad > uncheck

Scroll Direction.

SDXC card – Secure Digital eXtended Capacity format supports cards



up to 2 TB, compared to a limit of 32 GB for SDHC cards in the SD 2.0

specification. (SDXC host devices accept all previous families of SD

memory cards.)

Secondary mouse button – The right mouse button, used for things

such as bringing up contextual menus. On a single-button mouse you

can achieve the same effect by holding Control and clicking the

primary (left) button. You can swap over the left and right buttons if

desired (see Primary mouse button).

Select – single clicking an item or click dragging (high lighting) a

selection of objects. Whole words may be selected by double clicking

on the word.

Server – The storage area where all the programs and user partitions

are kept. Shift Key – the keyboard shift key.

Snow Leopard: OS X 10.6 – Snow Leopard, more formally known as

OS X 10.6, is the sixth in the series of Unix-based operating systems

from Apple.

Software – Software includes any program that can be stored and

used on a computer. The term usually refers to both applications and

operating systems.

Sleep – Allows you to “turn off” your Mac, conserving power, without

actually having to restart the Mac from scratch when you turn it back

on. Macs support various sleep modes: Quick sleep, which keeps the

memory powered up; Deep sleep (or hibernation), which writes the

memory contents to disk and completely powers off the Mac; and Safe

sleep, which keeps the memory powered but also writes the memory



contents to disk in case there’s a power failure. Most desktop Macs

default to Quick sleep, while most MacBooks default to Safe sleep.

SMC – System Management Controller. Sometimes resetting the SMC

can fix problems that don’t respond to other troubleshooting

techniques. Learn more here: http://support.apple.com/kb/HT3964.

Spaces – The Spaces feature lets you create multiple versions of your

desktop, each with its own set of windows and applications. For

example, you might want to create one space for work and one for

play. You can switch between spaces with the tap of a key or the click

of a mouse.

Spinning beach ball – Officially known as the “spinning wait cursor”.

The rainbow-coloured spinning disc that signifies that an app has

become unresponsive.

Spotlight – The Mac’s built-in search engine, accessed by pressing

Command-Space or clicking the top-right magnifying glass icon.

Allows you to search through your files, data, music, applications and

so on. Also available on iPhone/iPod Touch by swiping to the right on

the first Home screen.

SSD (Solid State Drive)- an alternative to a traditional hard drive and

similar to flash storage. It is very fast, reliable, durable and only takes

minimal space.  A  SSD uses flash memory-sticks inside an enclosure

and thus can be connected with SATA.

Stacks – Folder icons in the Dock that, when clicked on, reveal their

contents in a fan, grid, or list format. It’s a great way to quickly access

the contents of a folder while reducing visual clutter. To change the



appearance of a stack, right-click (or Control-click) its icon in the Dock

and choose from Fan, Grid, List, or Automatic.

Startup disk – The hard disk containing Mac OS X that is read when

your Mac starts up. Normally this is the built-in hard disk, but you can

use an

Spyware – Spyware is any software that has the ability to gather

information about a computer user, usually without the user’s

knowledge.

System File – a folder on the computer Hard Drive that contains

documents and programs needed to operate the basic systems of the

Mac. Do not attempt to open or change any of the documents in this

folder. Anything that may or can be changed in the system is done

through the Apple Menu and Control Panels.

System Preferences – A Mac OS X utility that allows you to set various

preferences for your Mac. It is found by clicking the Apple icon in the

upper left corner of your screen. Preferences are set via preference

panes; several panes are installed by default, and new ones can be

installed by 3rd-party software and drivers. Default preference panes

include Appearance, for customizing the look of the Mac interface, and

Sound, for controlling sound effects and input/output volume.

System Profiler – A utility (Applications > Utilities > System Profiler)

that displays details of your Mac’s hardware and configuration.

Tab Key – Used to move text across to fixed points in a document. Also

used to move the cursor around the desktop items (alphabetically) or

within fields of dialog boxes.



Target Disk Mode – A Mac startup mode whereby, instead of booting

into Mac OS X, the Mac’s hard disk appears as an external disk on

another Mac connected via a FireWire cable. This allows the contents

of the first Mac’s hard disk to be accessed even if the Mac isn’t capable

of booting (for example, if the OS has become corrupted). To activate,

hold down the T key while starting the Mac.

TB – Terabyte – a unit of measurement of storage. A terabyte is a

thousand gigabytes (though it can sometimes be slightly higher than

this, depending on interpretation). One byte is enough to store a

single letter of the alphabet. Commonly used to refer to hard disk size.

Terminal – A Mac app (Applications > Utilities > Terminal) that lets you

give textual commands to your Mac, rather than using a graphical

interface. Often used to perform low-level maintenance or

configuration tasks.

TextEdit – A Mac app that is included with Mac OS X that can create

and edit plain text and rich text documents.

Thunderbolt- Revolutionary I/O technology that supports high-

resolution displays and high-performance data devices through a

single, compact port. It sets new standards for speed, flexibility, and

simplicity. Move data to and from peripherals up to 20 times faster

than with USB 2.0 and up to 12 times faster than with FireWire 800.

Time Machine – Apple’s backup utility included in Mac OS X. When

enabled, it regularly backs up your files and application data to an

external (or network) hard disk. You can later retrieve the files or data

from any previous backup that exists on the backup disk.



Toolbars – Areas containing tools specific to that program; found at

the edges of the screen. Individual tools are selected by clicking them.

Trash – The Mac’s Trash can temporarily holds any files and folders that

you have deleted. You can delete a file or folder by dragging it to the

Trash icon in the Dock. To delete the contents of the Trash

permanently, right-click or Control-click the Trash icon and choose

Empty Trash.

Trojan Horse – A Trojan horse is a program, usually malicious, that

attempts to trick you into installing it by pretending to be something

else. If it’s successful, the Trojan can then carry out whatever task it was

designed to do, such as provide unauthorized access to, and control

of, your computer.

USB – USB (Universal Serial Bus) is a uniform connector designed to

simplify the process of connecting peripherals, such as printers or

keyboards, to a computer.

User Name – A name given you by Computing Services for your User

Partition. The name is some mix of your first and last names.

Virus – A virus is a software program, usually designed to cause harm,

that is installed and run without your knowledge.

VMware Fusion – A Mac application that lets you install Microsoft

Windows in a virtual machine (computer) on your Mac. You can then

run Windows apps and Mac apps at the same time. See also Parallels

Desktop.

VoiceOver – A Mac OS X accessibility feature that allows user interface

elements and paragraphs of text to be spoken by the Mac. Enable it



via Apple menu > System Preferences > Universal Access > Seeing >

VoiceOver.

Volume – A volume is a storage container that has been formatted with

a file system that your computer can recognize. Common types of

volumes include CDs, DVDs, hard drives, and partitions or sections of

hard drives. This includes the startup disk volume (usually called

“Macintosh HD”)

Wi-Fi – Wi-Fi (Wireless Fidelity) usually refers to a wireless networking

system that uses any of the 802.11 wireless networking protocols.

Widgets – Widgets are small applications that run in a confined

environment in OS X known as Dashboard. You can easily create your

own widgets using basic Web development methods.

Worm – A worm is a form of malware, or malicious software. A worm is

similar to a virus, but unlike a virus, it doesn’t need any help from

humans to spread. It can spread from computer to computer on its

own volition.

XML – XML (eXtensible Markup Language), like HTML, is a language

used to design and format web pages. XML, a subset of SGML

(Standard Generalized Markup Language), offers more flexible

formatting options than HTML does.


